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Unit 1: Getting Started 
Unit Objectives 
In this unit, you will be introduced to PowerPoint, explore the interface, learn basic concepts and 
apply various settings. Upon successful completion of this unit, you should be able to understand 
the following: 

 Introduction to PowerPoint 

 Basic Concepts 

 Settings 

2



Unit 1 Introduction to PowerPoint 
Learn Tasks 

PowerPoint Overview 

1) Why is PowerPoint a helpful tool for creating presentations?

a) It helps you write essays faster.

b) It allows you to share information in a clear and interesting way.

c) It adds random images to your slides automatically.

d) It removes all videos and pictures from your presentation.

2) Fill in the blank with the correct word.

PowerPoint allows you to use pictures, charts, and __________ to make your presentation more
fun and quickly understood.

• Videos

• Essays

• Homework

• Bookmarks

3) You should add as many pictures and videos as possible to every slide to make your
presentation have an exciting appearance.

• True

• False

PowerPoint Window 

Identify the following in the PowerPoint Window 

• File Tab

• Status bar

• Ribbon

• Slide Pane

• View Buttons
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Ribbon 

Match the following terms: 

a) Galleries 

b) Ribbon 

c) Dialog Box Launcher 

d) Contextual Tabs 

_____ Located at the top of the window and contains tabs, groups, and commands to help you 
build your presentation. 

_____ Appears when you select specific objects like pictures or charts and offer additional tools. 

_____ Displays visual style options, such as Themes, in a preview format so you can view the 
effect before applying it. 

_____ Opens a window with more advanced settings and controls for certain commands. 

 
Ribbon Tabs 

Review the following terms and descriptions and match the terms to correctly identify when you 
would use the Ribbon tabs. 

a) Design 

b) Insert 

c) Review 

d) Animations 

_____ Helps you improve the appearance of your presentation by inserting different colors and 
designs. 

_____ Helps you make objects on your slides move, like showing text or moving images. 

_____ Helps you add pictures, shapes, charts, and more to your slides. 

_____ Helps you check spelling, leave comments, and make changes. 

 
Customize Ribbon 

Place the steps into the correct order to successfully customize the Ribbon in PowerPoint. 

1) Open PowerPoint and go to the File tab at the top left corner of the window.  

2) Use the Add or Remove button between the two columns to make changes.  

3) Select the OK button to save your changes.  

4) In the menu that appears, choose Options.  

5) In the PowerPoint Options dialog box, select the Customize Ribbon option.  

6) Choose the tab where you want to add or remove a tool from the right column.  
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Developer Tab 

Why would you enable the Developer tab in PowerPoint? 

a) To change the theme of your presentation

b) To access tools for adding interactive buttons, forms, and special commands

c) To insert pictures and videos

d) To apply transitions between slides

Quick Access Toolbar 

1) What is the main benefit of customizing the Quick Access Toolbar in PowerPoint?

a) It changes the background color of your slides.

b) It allows you to add animations quickly.

c) It gives you quick access to commands you use most often.

d) It adds new design themes to your presentation.

2) You can remove commands from the Quick Access Toolbar if you don’t use them.

• True

• False

Navigation Pane 

If the Navigation bar is not displayed make sure you are in the normal view. 

• True

• False
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Unit 1 Introduction to PowerPoint  
Practice Exercise 
 

Add a section, update the Quick Access Toolbar, and insert a new slide. 

1) Open U1 L1 Practice Exercise.pptx 

2) Add the New Slide command to the Quick Access Toolbar 

• File tab > Options > Quick Access Toolbar > Choose commands from: Popular Commands 
> New Slide > Add>> > OK 

3) Add a new blank slide after the final slide using the Quick Access Toolbar 

• Slide 15 > Quick Access Toolbar > New Slide > Blank 

4) Save to your course files 
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Unit 1 Introduction to PowerPoint 
Practice Questions 

1) The title Bar is located at the bottom of the window.

• True
• False

2) Review the following terms and descriptions and match the terms to correctly identify when
you would use the Ribbon tabs.

a) Galleries
b) Groups
c) Contextual Tabs

_____ It has similar commands to help you with different tasks. 
_____ It has different visual options and styles. 
_____ It has special tools just for working with pictures or charts. 

3) Match the following words into the correct category.

a) Design
b) Themes
c) Draw
d) Stencils

Ribbon Tabs Non-Ribbon Tabs 

4) Which of the following is not an option inside the Ribbon?

a) Merge
b) Slide Master
c) Add Table
d) Record

5) Which of the following is not a group inside the Developer Tab?

a) Code
b) Comments
c) Add-ins
d) Controls

6) The Quick Access Toolbar is great because it saves you time. Instead of looking for commands
in different places, you can have them organized in one spot.

• True
• False

7) The Navigation Pane in PowerPoint is a helpful tool that helps you move around and organize
your slides.

• True
• False
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Unit 1 Basic Concepts Learn Tasks 
 

Create a New Presentation 

Start a new blank presentation. 

1) Create a new presentation 

• File tab > New > Blank Presentation 

2) Save to your course files 

 
365 Web: 
1) Create a new presentation 

• Select the Create blank presentation button  

Online: 
1) Create a new presentation 

• Create or Upload button > PowerPoint presentation icon 
 

Open a Presentation 

Open an existing file. 

1) Open Open a Presentation.pptx  

2) Download the Open a Presentation 2.pptx file to your device and open it   

• File tab > Open > Browse > Downloads > Open a Presentation 2.pptx > Open 

3) Save to your course files 

 

Save a Presentation 

Save your presentation to your computer. 

1) Open Save a Presentation.pptx 

2) Save the presentation to the desktop on your computer 

• File tab > Save As > Browse > Select location  

• File name: Galaxy Presentation > Save 

3) Save to your course files 

 

Save a Template 

Save your customized template for future use. 

1) Open Save a Template.pptx 

2) Save the Template as “Mine” 

• File tab > Save As > Browse > Save as type: PowerPoint Template (*.potx) > File name: Mine 
> Save 

3) Save to your course files 
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Save a Presentation as a PDF 

Export your presentation to PDF format. 

1) Open Save a Presentation as a PDF.pptx 

2) Save the presentation as a PDF 

• File tab > Save As > Browse > Save as type: PDF (*.pdf) > Save 

3) Save to your course files 

 

Save a Presentation as Images 

Export your presentation to image files. 

1) Open Save a Presentation as Images.pptx 

2) Save the presentation as an image 

• File tab > Save As > Browse > Save as type: JPEG File Interchange Format (*.jpg) > Save 

3) Save to your course files 

 

Save a Presentation as a Video 

Export your presentation to video format. 

1) Save the Presentation as a Video.pptx 

2) Save the presentation as a video 

• File tab > Export > Create a Video > Create Video > Export 

3) Save to your course files 

 

Print a Presentation 

Print all slides. 

1) Open Print a Presentation.pptx 

2) Print the presentation 

• File tab > Print > Print 

3) Save to your course files 

 

Print Layout Options 

Match each print layout option with its description. 

a) Full Page Slides 

b) Notes Pages 

c) Outline View 

_____This option prints each slide on a separate page, filling up the entire page. 

_____This option prints your slides along with any notes you’ve added. Each page shows one 
slide and its accompanying notes. 

_____This option prints the text content of your presentation in an outline format. 

Print Handouts 
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For a Handout, what is the maximum number of slides you can use/import from PowerPoint? 

a) 2 

b) 4 

c) 6 

d) 9  
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Unit 1 Basic Concepts Practice Exercise 
Open, apply a theme, save, and print a presentation. 

1) Open U1 L2 Practice Exercise.pptx

2) Apply the Ion theme

• Design tab > Themes group > ION

3) Save the file as a PDF

• File tab > Save As > Save as type: PDF (*.pdf) > Save

4) Print the presentation in Grayscale

• File tab > Print > Settings: Color drop-down arrow > Grayscale

5) Save to your course files
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Unit 1 Basic Concepts Practice Questions 
1) Fill in the blanks with the correct words. 

 
Open PowerPoint and look for the __________ tab at the top-left corner of the screen. When you 
find it, select it. This will open a special view called the __________ view.  Enter a word or phrase 
related to your search, and PowerPoint will show you options matching your search. If you 
prefer to start with a blank slate, choose the __________ Presentation option.  

 
• File 
• Blank 
• Backstage 

 
2) It is possible to open the PowerPoint files shared with the user. 

• True  
• False 

 
3) What is the shortcut key used to save the PowerPoint file? 

a) Ctrl + A 
b) Ctrl + S  
c) Ctrl + D 
d) Ctrl + O 

 
4) Which of the following tabs has the “themes” group/option?  

a) Draw 
b) Design  
c) Animation 
d) Transition 

 
5) Which of the following is a file extension for the PowerPoint Template File? 

a) .pptx 
b) .pptm 
c) .potx  
d) .potm 

 
6) It is possible to save a select number of slides when saving the PPT as a PDF file. 

• True  
• False 

 
7) Match the following words into the correct category. 

a) WMV 
b) PNG 
c) MP3 
d) JPEG 

  
Non-Image Formats Image Formats 
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8) Which of the following formats helps you save the PPT file as a video file?

a) MP3
b) MP5
c) MP7
d) MP4

9) It is possible to print custom slides from a PPT.

• True
• False

10) Which of the following is not an option in the Print Layout Options?

a) Full Page Slides
b) Comments
c) Notes Pages
d) Outline

11) Printing handouts in PowerPoint allows you to make copies of your presentation with several
slides on each page.

• True
• False

12) Printing in grayscale is helpful when saving ink or printing documents that don't need colors.

• True
• False
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Unit 1 Settings Learn Tasks 
 

Presentation Properties 

Update presentation properties to add title, author, subject, and keywords. 

1) Open Presentation Properties.pptx 

2) Update the following presentation properties: Title: “Exploring the Solar System”; Author: Add 
your name; Subject: “Space Science”; Keywords: “Planets”, “Space”, “Science” 

• File tab > Info > Properties drop-down > Advanced Properties > Summary tab  

• Title: Exploring the Solar System 

• Author: Add your name 

• Subject: Space Science 

• Keywords: Planets, Space, Science 

• OK 

3) Save to your course files 

 
 

Set as Read-Only 

Set the presentation as Read-Only. 

1) Open Set as Read-Only.pptx 

2) Set the presentation to open as Read-Only 

• File tab > Info > Protect Presentation > Always Open Read-Only 

3) Save to your course files 

 
 

Password Protect 

Apply password protection to the presentation. 

1) Open Password Protect.pptx 

2) Encrypt the presentation with the password “Space” 

• File tab > Info > Protect Presentation > Encrypt with Password > Space > OK > Space > OK 

3) Save to your course files 

 
 

Mark as Final 

Which of the following markers identifies a presentation as marked as Final? 

a) Flag 

b) Logo 

c) Banner  

d) Marker 
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Compatibility  

Check a presentation for compatibility issues. 

1) Open Compatibility.pptx

2) Review the Compatibility Report

• File tab > Info > Check for Issues > Check Compatibility

3) Save to your course files

Inspect a Presentation 

Inspect a presentation for hidden or personal information. 

1) Open Inspect a Presentation.pptx

2) Inspect the presentation

• File tab > Info > Check for Issues > Inspect Document > Inspect

3) Save to your course files
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Unit 1 Settings Learn Tasks 
 

Update properties, check compatibility, and mark a presentation as final. 

1) Open U1 L3 Practice Exercise.pptx 

2) Add the title “PSC” and “Q&A” as a tag in the Properties section and check for compatibility 
issues 

• File tab > Info > Properties  

• Title > PSC 

• Tags > Q&A 

• Check for Issues > Check Compatibility > OK 

3) Mark the presentation as Final 

• File tab > Info > Protect Presentation > Mark as Final > OK > OK 

4) Save to your course files 
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Unit 1 Settings Practice Questions 
1) Which of the following is not an option inside the Advanced Properties Dialog Box?

a) Summary
b) Details
c) Statistics
d) Contents

2) Setting a presentation as read-only is helpful when you want to keep the content the same.

• True
• False

3) Which of the following tabs has the Password Protect option?

a) Password
b) Privacy
c) Protect
d) File

4) When you mark a presentation as final, you declare it as finished and ready for others to see.

• True
• False

5) Which of the following is not an option inside Document Inspector?

a) Comments
b) Tags
c) Ink
d) Embedded Documents
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Unit 1: Create Project 
The Create project is designed to allow the application and demonstration of new knowledge, 
skills, and personal creativity to produce a project-based result while integrating rubric 
requirements using a checklist. 

Tip: While working on your project, remember to save your progress regularly. This will allow you 
to come back to it later. To continue working, open the document, then launch the platform 
using the Add-in whenever you're ready. 

To begin, review the Project Specifications. 

Choose from one of the projects below: 

• Event Planning Presentation: Create a presentation to plan and outline the details of an
upcoming event.

• Project Proposal Presentation: Develop a presentation for a project proposal.

• Educational Lesson Plan: Design a presentation to support an educational lesson plan.

• Marketing Campaign Presentation: Prepare a presentation to outline a marketing
campaign.

• Your Own Project Proposal: Propose a project idea of your choice to your instructor for
approval. The goal is to develop a creative and feasible project idea that aligns with the
course objectives and your interests.

Required: 

� Add at least five slides with text 
� Check for Compatibility 
� Inspect the Presentation
� Add Presentation Properties 
� Set the Presentation Properties 
� Set the Presentation to Print Notes Pages 
� Set the presentation as Read-Only or Mark as Final 

Practice: 

� Customizing the Ribbon 
� Customizing the Quick Access Toolbar 
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Unit 1: Objective Assessment 

1) PowerPoint helps you organize your information, like using bullet points or numbers to
illustrate important facts.

• True
• False

2) The title Bar is located at the bottom of the window.

• True
• False

3) Which of the following options helps you fix/adjust the size of slide navigation or outline view
pane?

a) Title Bar
b) Split Bar
c) Status Bar
d) Slide Pane

4) Review the following terms and descriptions and match the terms to correctly identify when
you would use the Ribbon tabs.

• Galleries
• Groups
• Contextual Tabs

Galleries  It has similar commands to help you with different tasks. 
Groups  It has different visual options and styles.  
Contextual Tab  It has special tools just for working with pictures or charts. 

5) Match the following words into the correct category.

a) Design
b) Illustrations
c) Draw
d) Images

Ribbon Tabs Non-Ribbon Tabs 

6) Which of the following tabs helps with “checking and editing your presentation”? 

a) View
b) Review
c) Developer
d) Design

7) Which of the following is not an option inside the Ribbon?

a) Merge
b) Slide Master
c) Add Table
d) Record
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8) Which of the following is not a group inside the Developer Tab? 

a) Code 
b) Comments  
c) Add-ins 
d) Controls 

 
9) The Developer Tab is a default option in the Ribbon. 

• True 
• False  

 
10) The Quick Access Toolbar is great because it saves you time. Instead of searching for 

commands in different places, you can have them organized in one spot.  

• True  
• False 

 
11) The Navigation Pane in PowerPoint is a helpful tool that helps you move around and organize 

your slides.  

• True  
• False 

 
12) A thumbnail image of the first slide can give you a preview of how the slides will appear with 

that particular theme or template. 

• True  
• False 

 
13) It is not possible to open the PowerPoint files shared with the user. 

• True 
• False  

 
14) What is the shortcut key used to save the PowerPoint file? 

a) Ctrl + A 
b) Ctrl + S  
c) Ctrl + D 
d) Ctrl + O 

 
15) The Save option is located in which of the following tabs? 

a) Home 
b) File  
c) Insert 
d) View 

 
16) Which of the following tabs has the themes group/option?  

a) Draw 
b) Review 
c) Design  
d) View 
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17) Which of the following is a file extension for the PowerPoint Template File?

a) .pptx
b) .pptm
c) .potx
d) .potm

18) It is possible to save the select number of slides when saving the PPT as a PDF file.

• True
• False

19) Which of the following is a publishing option when saving the PPT as a PDF file?

a) Outline View
b) Videos
c) Images
d) URLs

20) Match the following words into the correct category.

a) WMV
a) PNG
b) MP3
c) JPEG

Non-Image Formats Image Formats 

21) Which of the following formats helps you save the PPT file as a video file?

a) MP3
b) MP5
c) MP7
d) MP4

22) It is possible to print custom slides from a PPT.

• True
• False

23) Which of the following is not an option in the Print Layout Options?

a) Full Page Slides
b) Comments
c) Notes Pages
d) Outline

24) Outline View includes slide titles and text to help you focus on the main points and structure.

• True
• False

25) Printing handouts in PowerPoint allows you to make copies of your presentation with a single
slide on each page.

• True
• False
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26) Printing in grayscale is helpful when saving ink or printing documents that don't need colors.  

• True  
• False 

 
27) Which of the following is not an option inside the “Advanced Properties” Dialog Box? 

a) Custom 
b) Summary 
c) Numbers  
d) Contents 

 
28) Match the following words into the correct category. 

a) Subject 
b) Categories 
c) Print 
d) Share  

 
Non-Properties Elements Properties Elements 

  
  

 
29) Setting a presentation as read-only is helpful when you want to keep the content the same.  

• True  
• False 

 
30) Which of the following tabs has the Password Protect option? 

a) Password 
b) Privacy 
c) Protect 
d) File  

 
31) When you mark a presentation as final, you declare it as finished and ready for others to view.  

• True  
• False 

 
32) If there are compatibility issues in the new PPT, then there might be issues when it is opened 

in an older PowerPoint Version. 

• True  
• False 

 
33) Which of the following is not an option inside Document Inspector? 

a) Comments 
b) Tags  
c) Ink 
d) Embedded Documents 
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PowerPoint Unit 1 Key Terms 
Term Definition 

Compatibility Ensure your presentation works well on different devices and software 
versions. 

Contextual Tabs Tabs that appear in the Ribbon when certain objects or elements, such as 
images or charts, are selected.  

Developer Tab A specialized tab in PowerPoint that provides advanced tools and features 
for creating interactive and customized presentations. 

Dialog Box 
Launcher 

A small icon or button within a group in the Ribbon, represented by a small 
arrow or ellipsis. 

Galleries Visual displays within the Ribbon that present different options or styles in 
a graphical format. 

Groups Within each Ribbon tab, groups are clusters of related commands and 
tools that serve a specific function or purpose. 

Handouts Make copies of your presentation with several slides on each page to 
distribute to others. 

JPEG Joint Photographic Experts Group, a standard image file format 
commonly used for photographs and realistic images. 

Min/Restore/ 
Max/Close Buttons 

These buttons control the size and closure of the PowerPoint application 
window. 

Navigation Pane A pane located on the left side of the PowerPoint window that displays a 
list of thumbnail images representing the slides in a presentation. 

PDF Portable Document Format, a file format commonly used for sharing and 
distributing documents, including presentations. 

PNG Portable Network Graphics, a common image file format that supports 
lossless compression. 

PowerPoint A computer program that helps you make presentations. 

Quick Access 
Toolbar 

Positioned above or below the Ribbon, it offers quick access to frequently 
used commands, and you can customize it to add or remove commands 
according to your preference. 

Read-only Use this feature to share presentations with others to view only and not 
make changes in the file. 

Ribbon The main interface in PowerPoint that provides access to commands 
categorized into groups for clear navigation and execution. 
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Ribbon Tab The interface at the top of the window that includes tabs and groups to 
organize a range of commands and tools, serving as the main control 
center to access different features and functions within the application. 

Slide Navigation 
Pane 

It displays thumbnail views of each slide, helping you organize and 
navigate through slides in your presentation. 

Slide Pane This is the main workspace where you view and edit the selected slide. 

Split Bar By dragging this bar left or right, you can adjust the size of the Slide 
Navigation or Outline View pane. 

Status Bar It shows presentation information, such as the current slide number and 
total number of slides, and includes buttons for Notes and various viewing 
options. 

Template A pre-designed and formatted file that serves as a starting point for 
creating new presentations. 

Theme A predefined set of design elements and formatting styles that determine 
the overall appearance and visual consistency of a presentation.  

Title Bar Located at the top of the window, it displays the name of the open 
presentation. 

View Buttons These buttons allow you to switch between different views of your 
presentation, such as Normal, Slide Sorter, Reading, and Slide Show. 

Zoom Slider Positioned on the status bar, it enables you to adjust the zoom level of your 
slides, either by using the minus and plus buttons or by dragging the slider. 
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